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About this course Objectives of the course Upon Completion of this course you will be able to: - Access the Knowledgeware working environment - Manage the Knowledgeware working environment - See how collaborative work affects knowledge features - Use parameters, formulae and design tables - Create parametric parts and assemblies - Share parameters and re-use relations



Targeted audience CATIA V5 Users
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Prerequisites Students attending this course should have knowledge of CATIA V5 Part Design and CATIA V5 Assembly Design
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Table of Contents (2/2) Importing Existing Checks Using Rule Bases Grip Assembly Recap Exercise To Sum Up
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Introduction to Common Knowledge Tools You will become familiar with the general Knowledge concepts :
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• Knowledge fundamental concepts • Accessing the tools • Terminology • Knowledge Settings
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What is CATIA V5 Knowledgeware ? CATIA V5 Knowledgeware is a set of tools intended to assist engineering decisions. It automates design and detects predefined design errors for maximum productivity. Knowledgeware enables users to:
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Automate product definition and create generic models in order to increase productivity. Capture corporate engineering knowledge and easily share know-how among all users. Ensure compliance with corporate standard. Guide and assist users through their design tasks. Allow early attention to final design specifications preventing costly redesigns.



These four different wheels have been generated from the same CATIA file, in a very simple way.
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Accessing Common Knowledge Tools 1



From the Knowledge toolbar:



2



From Tools -> Formula …
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Access to the Formula Dialog Box
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Terminology



User Parameter



A Parameter is a property of a CATIA document defined as a feature. It has a value and can be constrained by a Relation.



A Relation is a generic name for knowledge features : Formulas, Design Tables ... • A Formula defines how a parameter is to be calculated with respect to other parameters of the document
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Example: Length_of_Circle = 2 * Pi * Radius_of_Circle. A Design Table is a MS Excel or text table constraining a set of parameters. Each column of the table defines possible values of a concrete parameter (its name is associated to the name of the column). Each row of the table defines a possible Configuration of this set of parameters. A Configuration is a set of coherent values of a set of parameters.
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Knowledge Settings (1/4) Customizing the Specification Tree 1)



Displaying the parameters in the tree defined in the part document



2)



Displaying the relations in the tree defined in the part document



1
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Knowledge Settings (2/4) Customizing the Specification Tree 1)



Displaying the parameters in the tree defined in the product document



2)



Displaying the relations in the tree defined in the product document



1
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2
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Knowledge Settings (3/4) Select the corresponding option if you want … 1)



the value of the parameter to appear in the tree:



2)



the formula driving the parameter to appear in the tree:



3)



to surround the parameters’ names by the Symbol ‘name’:



4)



to synchronize Design Tables select required option



1 2
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Knowledge Settings (4/4) Select the corresponding option if you want … 1)



to load extended language libraries



2)



the system to load all available libraries



3)



to select individual packages to be loaded



1 2
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Common Knowledge Tools You will learn how to create and to use common knowledge tools
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Introduction Creating and Using Parameters Creating and Using Formulas Creating and Using Design Table Creating and Using Power Copy Common Knowledge Tools Recommendations Common Knowledge Tools Exercises To Sum Up
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Introduction Basic tools of Knowledgeware allow you to easily control the size or the geometry of simple shaped parts, theoretically without knowledge of a design concept. This can be done on different levels: A part can be controlled on basic level using Formulas between parameters. The designer can create a set of User Parameters and control the part only by changing these parameters’ value. Values of these parameters can then be linked in a Design Table: to modify the part simply choose the required configuration set.
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Steps before parameterizing a part: Check the part’s complexity Imagine all the possible ways of evolution of the part Notice the main variable dimensions and the way they evolve together Eventually select the best way to parameterize the part Then you can start parameterizing the part…
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User parameters



Formulas



Design table
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Creating and Using Parameters
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You will learn how to create and manage parameters :
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What are Parameters? (1/2) Many types of parameters:



Real, Integer, String, Boolean, Length, Mass...



Two kinds of parameters: Intrinsic parameters that are generated when creating any geometry and features. They define intrinsic properties of features (depth, offset, activity, …) User parameters, especially created by the user, define extra pieces of information added to a document. User parameters can be defined at different levels: Part level Assembly level Feature level



Parameters at Assembly level



Parameters at Part level



User parameters can either be defined:
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With single value (continuous). In this case, the parameter can take any value. Or with multiple values (discrete). In this case, the parameter can only take the predefined values given at its creation.



Parameters at Feature level



Any parameter can be: defined or constrained by relations used as argument of relations
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Intrinsic parameters
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What are Parameters? (2/2) Parameters in a Product



Length Type



User Parameters defined on a CATProduct Real Type
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String Type



Parameters defined on a CATPart
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Why Use User Parameters? To have an immediate access to the parameters that pilot the geometry and to easily change their value. To centralize key information so that any new user on the model can use it immediately. To refer easily to the same parameter when editing relations. With User Parameters, you can create generic models that are driven only from the User Parameter node. All the key information of the model is accessible from this place of the part, so that you don’t need to search in the PartBody to change the number of spokes, for instance.
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Edition of the user parameter
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Creating User Parameters (1/2) 1



Click on the f(x) icon. The Formulas panel is displayed.



2



Select the desired type of parameter and then specify Single Value or Multi Value option.



3



Click on New Parameter of type button to create the parameter.
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3
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2
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Creating User Parameters (2/2) 4



5



You can rename the parameter by typing a new name in the Edit name field; and attribute it a value by filling the Edit value field. Click on the OK button to validate the creation of the parameter and to close the Formulas panel. The new user parameter is added to the specification tree.
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6



The new parameter appears at the end of the parameters list with default name (here Real.1) and default value 0.
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Creating a User Parameter with Single Value 1



Click on the Formula icon; the Formulas panel has been opened



2



Choose the Single Value option



3



Choose the type Length in the list of possible types



4



Click on the New Parameter of type button The new parameter with a default name (Length.1) appears at the end of the parameter list. Click Apply to confirm the creation of the new parameter
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3



2



4 Type of parameter 5
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Creating a New Parameter with Multiple Values 1



Click on the Formula icon



2



Choose the type String and Multiple Values option



3



Click on the New Parameter of type button
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The panel of the Value List appears: -Type the first value in the first field, then Enter (the value appears in the second field) -Type the second value in first field, then Enter (the value appears in the second field)



4



Click OK to confirm



5



Double-Click the Parameter in the Specification Tree



6



Select your desired value
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Click Click
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Editing a User Parameter (1/2) 1



Double-Click a Parameter in the Specification Tree



2
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3
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Check the Parameter definition and edit it



Change the Parameter’s value and Click OK to confirm
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Editing a User Parameter (2/2) A number of useful capabilities are available from the contextual menu of parameter edition box: To edit a formula To specify a tolerance for the Length and Angle parameters To change the step incremented or decremented of the value field To specify an interactive measure Right-Click the field value in the Edit Parameter Panel



To transform a single value parameter in a multiple values parameter or to edit the values of an already multiple values parameter To specify the lower and upper bounds of the parameters value
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To add a comment or specify an existing one



Instructor Notes:



Copyright DASSAULT SYSTEMES



To lock the parameter’s value: the right field of the edit parameter panel becomes grey tint To hide the parameter in the tree
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Creating and Using Formulas
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You will learn how to create and use formulas:
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What are Formulas? Formulas are relations used to define or constrain any parameter. Formula can be defined with parameters, operators and functions. A formula is created from the moment you attribute a user parameter to a feature, for example. The left part of the relation is the parameter to constrain and the right part is a statement.
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Once it has been created, a formula can be manipulated like any other feature from its contextual menu.
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Why Use Formulas? (1/2) Formulas are used to define relations between any parameters or components. Thanks to formulas, you can easily create generic models. For instance, many parameters (either user or intrinsic) can be made equal, so that you just have to edit one chosen parameter to modify all the geometry.



All the sides of this cube are made equal to a user parameter, by using formulas.



When the value of the driving parameter changes, the value of all the relative parameters also changes.
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With a formula it is also possible to define any mathematical relation between parameters.
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Why Use Formulas? (2/2) Formulas also allow you to calculate component’s properties, thanks to predefined functions. For example, a formula can calculate a part’s wet area:
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Some of these functions also allow you to drive parametrical geometry:
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Creating a Formula (1/2) You can create formulas with ‘dimensions’ or user parameters. 1



You can access the Formula Editor through different means:



- Click on the f(x) icon ; in the Formulas panel, use the filter to select the parameter you want to edit. Either double-click on this parameter or click on the Add Formula button.



Double-click on the parameter in the list or click on ‘Add Formula’ button



OR
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- In the specification tree double-click on the parameter or on the dimension you want to add a formula to. Right-click in the Value field and select ‘Edit formula’ in the contextual menu.
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or…
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Creating a Formula (2/2) 2



The Formula Editor panel appears. Enter the right side of the formula in the formula editor field.



enter the formula here use the dictionary to select a parameter or a function



Check the Incremental mode button in order to display in the dictionary only the parameters of the feature selected in the specifications tree or in the 3D. If this option is not checked, will be displayed not only the parameters of the selected feature but also those of the features under it. Click to open the language browser Click to attach an URL or a comment to the formula
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Click on the Eraser to delete all the content of the formula field



3



Click on OK to validate the creation of the formula. The Formula is added to the Relations node in the specification tree.
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Using Functions in Formulas (1/3) When you are editing a formula, you have the possibility to use predefined functions, especially measures. The functions allow you to capture values from the geometry. For instance, the functions of the Measures dictionary allow you to define a parameter as:
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• a distance between two points • the minimum radius of a curve • the total length of a curve • the length of a curve segment • the area of a surface or a sketch • the perimeter of a surface • the volume of a PartBody or a closed surface • an angle, oriented or not, between two lines, directions, or planes



You can also use the functions to define a geometry parameter, like a point, a line, a curve, a surface, and so on. Use the CATIA Knowledge Advisor Documentation for more information on how to use functions.



To make sure that you have access to all these functions, check that the option ‘Load extended language libraries’ is selected in Tools > Options > General > Parameters and Measures: ‘Knowledge Environment’ Tab.
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Using Functions in Formulas (2/3) 1



In the Formula Editor panel, select the ‘Measures’ item from the Dictionary list.



2



The list of measures functions appears. Select for example the ‘length(Curve,Point,Boolean)’ item by double-clicking on it.
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1
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2
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Using Functions in Formulas (3/3) 3



4



The length function is added to the Formula Editor.



You now need to fill the arguments of the function. The function description informs you of the nature of the arguments.



3



For each argument, check that the cursor is positioned where the argument is intended to be typed, and then select the corresponding feature in the tree.
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Of course, when the argument is an integer or a Boolean, you can just type it. In our example, third argument is a Boolean: type ‘True’ if the length is to be calculated from the origin, ‘False’ if the length is to be calculated from the curve end. 5



Validate by clicking on OK.



6



CATIA may ask you if you want the relation to be updated automatically with global update. We advise you to answer ‘Yes’.
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4



5
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Editing a Formula



1



Open the ‘Relations’ node in the Specification Tree



2



Select the formula to be edited Double-click on the formula or Right-click the formula selected: Formula Object->Definition command from the contextual menu
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3



Check the formula definition in the formulas Editor dialog box



If needed, use this icon to erase the statement field:
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Creating and Using Design Tables
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You will learn how to create and manage Design Tables …
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What is a Design Table? The purpose of the Design Table is to drive the parameters of a CATIA document from external values. The Design Table provides you with a mean to create and manage component families. These components can for example be mechanical parts just differing in their parameters’ values. A set of parameters’ values is called a configuration and is registered in a row. A Design Table can be created: from the CATIA document parameters, from an external file. The values are stored either in a Microsoft ® Excel file on Windows™ or in a tabulated text file.
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The Knowledge Toolbar : Design Table icon



If you create the design from an existing file, it is possible to indicate the sheet number where the table is found
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Why Use Design Tables? To predefine possible configurations of the model and to ease dimensions’ modifications. To select the only realistic configurations of the component. To link parameters’ values that can’t be expressed with a mathematical relation. To create part families.
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Here is a part whose main dimensions are driven by a design table
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When you change its configuration, three parameters are updated at a time, included an intrinsic parameter (which access is not easy)
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Creating a Design Table (1/2) Click on the Design Table icon



1



2



The Design Table creation panel is opened. Select the option Create with current parameter values. Click on OK.



Select the parameters to add to the design table and use the arrows to add them to the list. Click on OK.
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3



4



Specify the folder and the file name where the data are stored. Click on the Save button.
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Creating a Design Table (2/2)



5 The Design Table dialogue box has appeared. The Design Table contains only one configuration: the current one. If you want to add more configurations, click on the Edit table button. Click OK to confirm the Table creation.



The Design Table feature appears in the specification tree within the Relations node
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6
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Creating a Design Table with an Existing File (1/2) You can also create a design table from an already existing file.



1



3



Create a excel file with following configurations. Save it as Table_Washer on your local directory



2



Load the part and select the Design Table icon. Select the option ‘Create a design table from pre-existing file’



Specify the external file containing data of your design table. Click the Open button
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4
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Click yes if you want an automatic association between columns of the external file and parameters of the CATIA document
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Creating a Design Table with an Existing File (2/2) When using an existing file, you have to manage the associations between columns and parameters. Here are a few pieces of advice to have them automatically made. 1



Automatic association occurs between parameters and column having exactly the same spelling (watch out for blank spaces and capital letters)



2



In the external file, make sure to specify the units of the values in the top case of the column. If this is not done CATIA considers they follow the international system (meters for length etc…)



Same spelling: association OK
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3



A Capital letter has been forgotten: auto association not done
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If the external file is a text file, make sure you have only one tab space between the titles and between the values
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Editing a Design Table (1/2) Double click on the Design Table object in the specification tree to open the Design Table panel



2



Click on Edit table Button to open the corresponding Excel file Under Windows
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1
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Editing a Design Table (2/2) 3



In the Excel table, you can: • change the parameters’ values • add new configurations by adding new rows • delete existing configurations • add a new column if you want to link another Catia parameter to the design table. In this case, you will have to associate the new parameter to the new column



4



Save the Excel file and close the application



5
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6
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A information panel is displayed. It informs you that the Design Table has been updated in accordance with the file. Click on Close. Click Apply into the CATIA Design table dialog box, the document is updated automatically.
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Managing Design Table Associations (1/2) The associations between driven parameters of a Design Table and driving parameters of an external file can be changed if they are not correctly linked or used 1



Double-click on the Design Table object in the specification tree to open the table panel
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Those associations are not correctly connected
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This column is not associated



2



Select Associations tab in the Design Table dialog box
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Managing Design Table Associations(2/2) 3



Here are the tools to manage the associations



Filters to sort out parameters displayed in the field below Parameters of the document that are not driven and obey the request of the filters above
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List of columns of the external document that have not been associated yet



Click on this button to create user parameters having the same name as columns that are not yet associated, the association is automatic
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List of associations already done



Click on this button to undo the association that is selected in the field above



Click on this button to associate the parameter and the column that are selected in the fields above



Use the arrow buttons to reorder the selected association



Click on this button to rename associated parameters with the names of their associated columns
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Using a Design Table



1



Open the Relations node in the specification tree and Double-click on the Design Table element.
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2



3



Click OK to confirm.
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The Design Table panel opens. Here row is selected. Select another one by double-clicking on it.
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Creating and Using Power Copy You will learn how to create and store reusable components called Power Copy.
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Power Copy Presentation Creating a Power Copy Saving a Power Copy Instantiating a Power Copy To Sum Up
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Power Copy Presentation In this lesson, you will have an overview of ‘Power Copy’ and the ways it can be used.
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Power Copy definition
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Power Copy instantiation
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What is a Power Copy?
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Power Copy is a set of design features grouped together in order to be reproduced. It is a kind of advanced copying tool. While defining it, you can specify the inputs that the user should provide. During instantiation, you can customize it and insert it in the design of any part.



Power Copy tools are accessible from the menu ‘Insert > Knowledge Templates’ in various workbenches (For Example): Part design, Wireframe and Surface, SheetMetal Design
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Example of Power Copy (1/3)
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In this example, we want to create a ‘Power Copy’ which will require only a single ‘Line’ and ‘Plane’ as an input and create a ‘Drafted Rib’ from it.



These are the inputs that the user will specify during the instantiation of the ‘Power Copy’.
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Example of Power Copy (2/3)
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During the instantiation of the ‘Power Copy’, the user has to select inputs with respect to the destination part.
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Example of Power Copy (3/3) In this case, these are the geometries that the ‘Power Copy’ feature creates automatically.



Creation of rectangular sketch from the selected rib line.



Extrusion of this sketch up to the selected ‘Limiting Surface’
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Application of ‘Draft’ to the extruded faces.



Thus, in this example you have seen how a Power Copy feature can create a ‘Drafted Rib’ from a single ‘Line’ as input.
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Creating a Power Copy
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You will learn to create a Power Copy.
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Process for Power Copy Creation Creation of Power Copy consists of the following steps:



Making the Part ready for the creation of the Powercopy
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1
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2



Setting Definition



3



Identifying and naming inputs



4



Publishing Parameters



5



Setting Icon and preview properties
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How to Create a Power Copy (1/4) Once you have the right geometry in your CATPart, you can create the Power Copy.



Select Power Copy from the menu. (Insert > Knowledge Templates > Power Copy)



1b



Type the name of the Power Copy in the ‘Definition Tab’ of the ‘Powercopy Definition’ dialog box.



1c



From the specification tree, select the features that will make your ‘Power Copy’.
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1a
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On selecting the features, the ‘Inputs of components’ are identified. These depend upon the features that you select to make your Power Copy.
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How to Create a Power Copy (2/4) After selecting features making the Power Copy, you can give names to the geometric inputs. During instantiation, the user will be prompted to select the geometries based on these new names. In our case there are three inputs: A.



The edge (Edge.1) from ‘Rib_Sketch’ - > Using this sketch, the power copy creates the ‘Rectangular Sketch’



B.



The YZ plane on which the ‘Rib_Curve’ has been created.



C.



The shell face (Face.10) upto which the ‘Pad.5’ was extruded.



Let us give new names to these inputs from instantiation point of view. 2a Select inputs tab



2b



Select the input to be renamed



2c



Type a new name for the input.



2d



Using the arrow keys, reorder the inputs if required.



New Name:



2a



Limiting_Face Rib_Curve_Plane Rib_Curve
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2b



2c
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2d



Reordering the inputs is sometimes required for displaying the inputs in a specific order in the Power Copy instantiation dialog box.
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How to Create a Power Copy (3/4) After renaming the geometric inputs, you can publish parameters. During instantiation, the user can specify values for these published parameters.
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To publish the parameters,



3a



Select parameters tab



3b



Select parameter



3c



Check the ‘Published’ option



3d



If necessary, rename the parameter



Note that it will be easier for you to recognize them if you have already renamed parameters with knowledgeware tools. [ f(x) ]
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How to Create a Power Copy (4/4) Once parameters are published, you can select the icon for your Power Copy and make a screen grab to create a preview of your Power Copy for catalogs. 4a



Select ‘Properties’ tab 4b Select any icon from the available list.
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4c Prepare the CATPart window for the screen grab 4d Click on ‘Grab screen’ to make a screen grab and click OK to validate.



To prepare the screen grab, you can remove tree and compass from the window and get the correct zoom and orientation.
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Saving a Power Copy
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You will learn to save the Power Copy in a catalog.



Instructor Notes:



Copyright DASSAULT SYSTEMES



CATIA Knowledge Fundamentals



Saving a Power Copy If you don’t save the CATPart containing your Power Copy, you wont be able to instantiate the Power Copy. You can save the Power Copy in a new catalog and also in an existing catalog.
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You can also update a catalog which makes reference to the Power Copies of your CATPart.
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How to Save a Power Copy in a Catalog 1



Save the CATPart containing your Power Copy.



2



From the menu, select – Insert > Knowledge Templates > Save in Catalog



3a



Select the ‘Create a new catalog’ option and click the browse button (. . .) to define the path for new catalog.



3b



Select the correct path, type new name of the catalog and click Save. (The OK button of the ‘Catalog save’ dialog box will now be active)



3c



Now click OK to the ‘Catalog save’ dialog box.
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3a



3c
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3b



CATIA Knowledge Fundamentals



Instantiating a Power Copy
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You will learn to instantiate a Power Copy differently at different places by varying geometric inputs and parameters while instantiating.
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Power Copy instantiation
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How to Instantiate a Power Copy (1/4) First step of the Power Copy instantiation is accessing the Power Copy. You can access it: a) From the CATPart file containing it. b) From a catalog having its reference. c) By using a VB macro (Refer documentation) Before proceeding, please save all the CATIA documents that are attached to this screen to a local folder.



1 2



From the menu, select: Insert > Instantiate From Document Select the CATPart file which contains your Power Copy.
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3



Open the CATPart in which you want to instantiate the Power Copy.
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2



Click on Catalog browser and browse for the catalog.



3



After opening the catalog, double-click on ‘Power Copy’, then on ‘3 inputs’ and finally on ‘Drafted_Rib’ to open the instantiation dialog.



OR OR



2x



2x



2x
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How to Instantiate a Power Copy (2/4) Second step of the instantiation is selecting the geometric inputs of the PowerCopy. 4a Select the geometric inputs of the Power Copy as shown. For this example select the
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‘Limiting Surface’ and ‘Rib_Curve_Plane’ as shown.



Now the first two inputs remain the same for all the three green ‘Rib_Curves’. So in this case you can use the ‘Repeat’ option. Select the ‘Repeat’ option, select any one of the three green lines and click OK. Repeat



4b the same process for any one of the remaining two green rib lines.
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How to Instantiate a Power Copy (3/4) You can also change the values of the parameters that you have published during the Power Copy creation. In this example, we will enter different values for the last rib line. Select the remaining Rib_Curve and click the



5a ‘Parameters’ button.



5b Enter the values for the parameters as shown and close the ‘Parameters’ dialog box.



0.75 deg
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2.0 mm



5b Click OK to the ‘Insert Object’ dialog box to instantiate the last rib and then click ‘Cancel’ to dismiss it.



Instructor Notes:



Copyright DASSAULT SYSTEMES



CATIA Knowledge Fundamentals



How to Instantiate a Power Copy (4/4)
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The result of the Power Copy instantiation is inserted after the “in work object”.



The result of Power Copy instantiation is a set of editable features. They are not linked to the original features of the PowerCopy CATPart.
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To Sum Up ... You have learned:
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What is a Powercopy. Powercopy is a set of design features grouped together to be reproduced. It is an advanced copy tool. Powercopy tools are available in Insert menu in Part design, Wireframe and surface, sheet metal design workbenches.



How to create a powercopy. During creation you have to set definition, identify and name inputs, publish parameters, choose icon and preview. How to save a powercopy. Saving of the part containing the powercopy is necessary before using it for instantiation. You can also save the power copy in a catalog using the menu “Insert > Knowledge Templates > Save in Catalog”. How to instantiate a powercopy. For instantiation you have to first select powercopy which has been previously created. This can be done through two ways. First way is through catalog and second way is from menu “Insert > Instantiate from document”
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Common Knowledge Tools Recommendations
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You will get some pieces of advice on selecting and filtering parameters.
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Filtering Parameters (1/2) The Formulas panel as well as many Editor panels in which you may use parameters allow you to filter parameters in order to ease their selection. 1



When the selection panel is opened, first select your selection mode: incremental or not.



2



Then select in the specifications tree the feature that contains the parameters that you want to use.



Without the incremental mode checked, ALL the parameters of the Groove AND ALL those of its definition sketch are displayed.
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lots of parameters are displayed: activities, modes, etc.



With the incremental mode checked, the parameters of the Groove and ONLY the dimension parameters of its definition sketch are displayed.
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fewer parameters are displayed: only 7 where found for Groove.3
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Filtering Parameters (2/2) 3



If you still have too many parameters listed, you can use filters: you usually have the possibility to filter the parameters by types and by name. you can make a query per name …or per type:



or…
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select a type in the list above Types available in the “Filter Type” list are the types of the parameters found in the current selection.



4



You should now be able to select a parameter easily.
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Selecting Parameters When creating parametric models you often have to select a parameter to use it in a statement, in a design table, or simply to edit it. Here are different ways of selection. A



If the parameter is displayed in the specification tree simply click on it.



B



If the parameter is displayed in the 3D (assembly constraint for instance) you can also click on it in the 3D.



C



If you are using the Parameters Dictionary, you can either double-click on it in the list or click once on it in the 3D.
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x2



D



If you know the exact name of the parameter you can also type it…



Instructor Notes:



Copyright DASSAULT SYSTEMES



CATIA Knowledge Fundamentals



Bolt and Stringer Recap Exercises 20 min



Topics covered: Managing different parameter types Creating and using Formulas and Relations Creating and using Design Tables
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• • •
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Bolt Exercise Recap Exercise 1
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10 min
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Stringer Exercise Recap Exercise 2
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30 min



Instructor Notes:
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To Sum Up ...



You have learned how to use CATIA V5 Standard Knowledge Tools:



How to easily drive geometry using user parameters How to link parameters’ value using formulas
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How to predefine different configurations for a part using a Design Table
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Collaborative Work and Knowledge In this lesson, you will learn how to share parameters between documents and how to reuse relations developed by other people
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Introduction Managing External Parameters Importing Existing Rules Importing Existing Checks Using Rule Bases Grip Assembly Recap Exercise To Sum Up
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Introduction Collaborative Work allows you to reuse advanced Knowledge objects created by other users, by storing them in catalogs. Thanks to Collaborative Work, you can insert in your models: Checks, that are features that inform you if your model responds to predefined criteria. Rules, that allow you to define advanced relations between your parameters, generally relations based on conditional statements. Reactions, that are features that react to events on a defined object, generally updates. Rule Bases, containing Expert Checks and Expert Rules.
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In this lesson, you will also learn how to publish and import parameters and how to use parameters when designing in context.
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Check Rules Reaction



External published parameters



Rule Base
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Managing External Parameters
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You will get familiar with the use of external parameters, how they are created and what are the benefits in using them



Instructor Notes:
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What is an External Parameter? External Parameters are linked copies of parameters driven in an external document. It is possible to create them provided that the ‘Keep Link with selected object’ in the Tools / Option menu is activated.
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They can be created: automatically by referring to another part’s parameter in a relation, manually by using the Copy/ Paste Special – As Result With Link command.
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These two External Parameters are linked to their fathers in Wheel_Rim
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Why Use External Parameters? To reuse a parameter that drives a Part in another Part, in order to link their geometry. To be sure that the design of the two linked parts is consistent. To avoid manual updates of all the parameters that must have the same value in different parts.
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In this example, the hub needs to adapt to the rim’s holes. External parameters have been created in order to link the number of holes and the bolt pattern diameter.
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Here the Number_of_Bolt_Holes parameter has been copied with link from Wheel_Rim.CATPart to Wheel_Hub.CATPart
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Referring to External Parameters in Formulas (1/3) In a Formula, you can use parameters defined in external documents. This is possible between any types of document. 1



In the specification tree, doubleclick on the user parameter Axle_Diameter in order to edit it.



2



Copyright DASSAULT SYSTEMES



1
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2



In the contextual menu of the parameter’s value, select the ‘Edit formula’ option. The Formula Editor panel is displayed.
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Referring to External Parameters in Formulas (2/3)



3



Select the Piston_Head. The ‘External parameter selection’ panel is displayed.



Remark: The ‘External parameter selection’ panel is mainly used to select intrinsic parameters. In the case of user parameters, it is possible to directly select the parameter in the tree.



Select in the tree the user parameter Holes_Diameter. Validate by clicking on OK in ‘External parameter selection’, in ‘Formula editor’, and in ‘Edit Parameter’ dialog boxes.
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4
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Referring to External Parameters in Formulas (3/3)
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An external parameter has been created, Provided the following option was activated
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Why Publish Parameters? Publication of parameters is useful when replacing in an assembly a component which contains parameters that drive other components’ external parameters. If the exported parameters are published and if the parameters of the replacing component are published under the same name, they will inherit the control of the exported parameters. Otherwise the parameters of the replaced component will keep the control. In this example, the hub is linked to the rim: the hub reuses the number of holes and the pattern diameter of the rim. Let’s see the difference of behavior of the hub when replacing the rim, with its parameters published or not. The rim is replaced by a bigger one, the parameters of which are published under the same names than the first rim.
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The rim is replaced by a bigger one, the parameters of which are not published.
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The external parameters of the hub are still linked to the first rim. They are not updated.



The number of holes of the hub and the diameter of the pattern automatically adapt to the new rim.
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Publishing a Parameter (1/3) The Publication command is available in Assembly Design and in Part Design. It publishes geometry and parameters as well. 1



2
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3a



4a



Activate the part containing the parameter you want to publish.



2x



Select Publication… in the Tools menu:



If the parameter you want to publish is a user parameter, click on its icon in the tree.



The user parameter now appears in the list of published elements of the Publication dialog box.
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Publishing a Parameter (2/3) 3b



4b



If the parameter you want to publish is an intrinsic parameter, click on the Parameter button of the dialog box. Select the parameter: - directly in the dialog box - or by the intermediate of the geometry



Click on OK to validate the selection.



6b



The intrinsic parameter appears in the list of published parameters:
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5b
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Publishing a Parameter (3/3) 7 8



9
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10



11



Published Parameters appear in the list with a default publication name. To modify the publication name, first select the publication. Then select the name field. Edit the name and validate with Enter.



Validate the publication by clicking on OK.
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Your newly published parameters appear



12 under the



publications node of the active part
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Using Published Parameters (1/5) Published parameters are called when editing formulas. In this example, we are going to make equal the inner cylinder diameter to the head diameter.



1



2



2
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1
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Be activated on Guided_Part level and open the formula editor panel of Cylinder_InnerDiameter parameter.



Edit the formula by selecting the Head_Radius parameter: • under the Publications’ node of Guiding_Part • in the External Parameters of Guided_Part, provided that it has previously been copied with link. The copy with link is already made if you have used this external parameter before, or if you have intentionally copied/pasted it Special as result with link.
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Using Published Parameters (2/5) Published parameters are called when editing formulas.



The edited part has become contextual



3b



External Parameters linked to published parameters appear with a green Capital P on their icon in the tree
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3a
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Using Published Parameters (3/5) Some CATIA options can prevent the user from creating external parameters from unpublished parameters.



1



When this option “Restrict External selection…” is activated, and when you select an unpublished parameter in an external document, no external parameter is created and no link is kept: only the value of the parameter will be taken (as if the option ‘Keep link…’ was deactivated).
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2



The setting preventing the use of non published geometry also works with parameters
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In this case, the depth parameter of GuidingPart was not published and only its value (52mm) has been taken to edit this formula. Neither link nor external parameter are created.
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Using Published Parameters (4/5) When using published parameters you have to pay attention to the context assembly. 1 Context link



Knowledge link
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2
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The first time you use an external reference or a published external parameter, not only you create links to external information, but you also define a “context” link from the edited part to the root assembly (by default). The context link is unique and the product it is connected to is called the context assembly.



If the root product is not anymore the context product of Guided_Part, its icon indicates it is out of context.
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Using Published Parameters (5/5) When using published parameters you have to pay attention to the context assembly.



3



An external parameter which is created when the root product is not the context product will never be considered as connected to a published parameter.
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4



In this new context, try to create, in Guided_Part, a new formula referring to another published parameter of Guiding_Part.
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Isolating an External Parameter When you isolate an external parameter, you do not suppress it, you just break the link with the parameter from which it is copied. It becomes a simple user parameter. 1



Open the contextual menu of the external parameter you want to isolate, and select the Isolate command.
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2
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The isolated parameter is no longer linked to an external file. It now appears under the Parameters node, like any other user parameter.
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Importing Existing Rules
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You will get familiar with browsing catalogs in order to reuse rules
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What is a Rule? A rule is a set of instructions, generally based on conditional statements, whereby the relationship between parameters is controlled. A rule appears in the Relations node of the current document:
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In this example, the rule calculates the volume of the PartBody and sets the Material parameter in consequence with the result: if smartVolume(PartBody)< Limit_Volume { Material="Steel" }



if the volume of the PartBody is strictly inferior to a limit value, (here equals to 3000cm3) the Material is set to Steel



else Material="Chroma"



otherwise it is set it to Chroma



Here we have changed the wheel’s size by changing the configuration of the design table: the volume of the wheel has changed and its material has been updated automatically. Unlike the parameter and formula edition which are available to all CATIA users, the rule creation and edition require the Knowledge Advisor Product.
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Why Reuse Rules ? You may need to reuse rules for several reasons: To avoid creating and editing several times the same rule To share rules between several users To import someone else’s knowledge



You can import an existing rule from an external document through the catalog browser and adapt it to parameters of your document. The rule on Material that we have previously used on a rim can be reused on another model, a hub for instance.



Here the hub contains no rule on Material.
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The rule has been imported, and has automatically updated the Material parameter.
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Now the dimensions of the hub have changed and its volume has increased: the Material parameter has been update in consequence.
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Importing Data from Catalogs (1/3) In Mechanical Design 2 (MD2) product, existing relations such as Rules, Checks and Reactions can be reused in a document, provided that they are stored in a Catalog. Use Catalog Browser tool to import them into a part as a feature component. 1



Open the document in which you want to insert the relation.



4



Select the family containing the feature by doubleclicking on it. Click Click



5



2
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3



Then select the Relation by double-clicking on its name.



Click on the Catalog browser icon. The Catalog Browser dialog box has opened. Select the Catalog document containing the feature you want to import.
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Click Click
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Importing Data from Catalogs (2/3) 6



The Insert Object dialog box appears:



Name of the relation Type here the name for the relation you wish to see in the specification tree.
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Use this button to connect automatically parameters that have the same name
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List of inputs to complete Script of the relation
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Importing Data from Catalogs (3/3) 7



In the Insert Object dialog box, complete the relation by selecting the parameters you want to involve in it:



7a First select the Use identical name command to fill automatically the inputs



7b Then fill the remaining fields by



selecting the inputs in the specification tree



7a



7b
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8
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8



Click on OK to import the relation



9



The relation is imported in the Relations node and has taken effect
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Importing Existing Checks
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You will become familiar with browsing catalogs in order to reuse Checks.
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What is a Check? A Check is a set of statements intended to provide the user with a clue as certain conditions are fulfilled or not. A check does not modify the document it is applied to and just gives a design indication. A check usually appears in the Relations node of the specification tree with a traffic lights icon, getting red or green according to the check’s status.



Check status is OK.



Check status is not OK.
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There are three types of checks: Silent – the status of the check is only indicated by the feature’s icon. Information - the status of the check is indicated by the icon and an Information message occurs when the check is wrong. Warning - the status of the check is indicated by the icon and a Warning message occurs when the check is wrong.



Information message



Warning message Unlike the parameter and formula edition which are available to all CATIA users, the checks creation and edition require the Knowledge Advisor Product.



Instructor Notes:



Copyright DASSAULT SYSTEMES



CATIA Knowledge Fundamentals



Why use Checks? To check that a parameter or a component property responds to a technical limitation or to a schedule of conditions. To ensure compliance with the corporate design rules. To avoid update errors that are foreseeable. The check sends a warning message when editing the feature, so that the unsuitable value can be changed before update. For instance, this check verifies that this mechanical part respects a maximum mass:
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The designer edits the geometry of the part.
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The mass of the part has grown. A message informs the designer that it doesn’t respond anymore to the part specification.
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Why reuse Checks ? You may need to import existing checks for several reasons: To avoid creating and editing several times the same check. To share checks between several users. To import corporate knowledge implemented by someone else. As for rules, you can import an existing check from an external document through the catalog browser and adapt it to parameters of your document.
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For instance, the check on mass limitation can be reused in other cases, just by changing the inputs:
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Same reused check
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Importing Data from Catalogs (1/3) In Mechanical Design 2 (MD2) product, existing relations such as Rules, Checks and Reactions can be reused in a document, provided that they are stored in a Catalog. Use Catalog Browser tool to import them into a part as a feature component. 1



Open the document in which you want to insert the relation.



4



Select the family containing the feature by doubleclicking on it. Click Click



5



2
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3



Then select the Relation by double-clicking on its name.



Click on the Catalog browser icon. The Catalog Browser dialog box has opened. Select the Catalog document containing the feature you want to import.
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Click Click
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Importing Data from Catalogs (2/3) 6



The Insert Object dialog box appears:



Name of the relation Type here the name for the relation you wish to see in the specification tree.
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Use this button to connect automatically parameters that have the same name
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List of inputs to complete Script of the relation
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Importing Data from Catalogs (3/3) 7



In the Insert Object dialog box, complete the relation by selecting the parameters you want to involve in it:



7a First select the Use identical name command to fill automatically the inputs



7b Then fill the remaining fields by



selecting the inputs in the specification tree



7a



7b
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8
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8



Click on OK to import the relation



9



The relation is imported in the Relations node and has taken effect
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Analysing Checks The Global Analysis Tool is designed to manage Knowledge Expert and Knowledge Advisor Checks wherever they may be located in the specification tree. It helps to understand the validation status of the designs and allows navigation by checks or violations and highlights failed components. In the Knowledge toolbar, the « Check analysis toolbox » icon light indicates the active document Checks status: All the checks are updated and could be run successfully The checks need to be updated All the checks are updated and at least one of them is incorrect



Click on the



icon in the toolbar to access to the Check analysis window:
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The ‘Check mode’ displays only the Check features that failed when updating the check report. The ‘Failure mode’ displays all the items that failed when updating the check report.
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Click here to generate the customizable report. Click here to solve the checks created. Click here to launch correction (only available for Knowledge Expert Checks). Double click on an item to display the check and the items associated.



Click here to display or associate an URL.
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Using Rule Bases
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You will become familiar with the use of Rule Bases: you will learn how to import them from catalogs and how to analyze their results.
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What is a Rule Base? A Rule base is a Knowledgeware feature that contains Expert Rules and Expert Checks (see definitions below). Only the Expert Knowledge product allows you to create and edit Rule Bases. But with Mechanical Design 2 product, you can import and use existing ones in the documents you are editing. A Rule base contains Rule sets. There can be only one rule base per document (CATPart or CATProduct). A Rule Set includes Expert Rules and/or Expert Checks. There can be several rule sets in a single Rule Base.
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An Expert Check verifies for any feature of a given type the satisfaction of a specified condition. An Expert Check can be valid (green light) or invalid (red light). An Expert Check can have a correction action associated.
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An Expert Rule can also verify a specified condition for any feature of a given type. If this condition is satisfied, it applies a predefined action on the feature.
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Why Use a Rule Bases ? Expert Checks and Expert Rules can be used to prevent designers from not applying a project’s design specifications. In these examples, one specification is to make shells with an inside thickness of 5mm and an outside thickness of 0mm: Green tube: the designer made a shell without respecting the design specifications but an expert rule automatically corrected it.



Yellow tube: the designer made a shell without respecting the design specifications. There is no warning hence no correction.
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Blue tube: the designer made a shell without respecting the design specifications but an expert check signals it.
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Instantiating a Rule Base from a Catalog (1/4) 1



Open the document in which you want to insert the Rule Base.



2



Open the catalog referencing the rule base using the catalog browser.



3



Reach in the browser the Rule Base you want to instantiate and double click on it.



4



Select the way you want to reuse the Rule Base:
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Use Only will just run the rule base on your document without importing it and create a report in a directory of your choice Import with link will import a linked copy of the rule base in your document Import will make a simple (unlinked) copy of the Rule Base in your document
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Note that there is no Rule Base in the receiving document



x2
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Instantiating a Rule Base from a Catalog (2/4) If your document already contains a Rule Base, there are different cases. CASE A



The receiving document already contains a Rule Base linked to an external document. You will not be able to add Rule Sets from the instantiated Rule Base. The only possible option is ‘Use Only’.



1



2
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x2
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3



Here only the Use Only option is available because a linked Rule Base already exists in your destination document
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Instantiating a Rule Base from a Catalog (3/4) CASE B



The receiving document already contains a Rule Base. Rule Sets have similar names. In order to add Rule Sets from the instantiated Rule Base you will have to solve the naming conflict.



1



3



4 2
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x2



When instantiating several Rule Bases take care of not having identical names of Rule Sets.
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Click on Yes to replace the Rule Set.
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Instantiating a Rule Base from a Catalog (4/4) CASE C



Your receiving document already contains a Rule Base. You will be able to add Rule Sets from the instantiated Rule Base provided that the Rule Sets do not have identical names.



1



2
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3
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Here we have re-used a Rule Base containing Rule Sets having different names than the ones already existing, so they have been added in the Rule Base of the document.
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Solving a Rule Base (1/3) When you solve a Rule Base, you run all the expert rules contained in it and make CATIA verify that the expert checks are respected in the whole document. 1



In the Rule base contextual menu select ‘Manual Complete Solve’
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2
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2a



Checks that are not respected and Rules Set containing them have a red traffic light icon.
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Solving a Rule Base (2/3)
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2b
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While solving the Rule base, Expert Rules have run and transformed feature attributes (shell thickness in this case) in according to what is defined in its script.
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Solving a Rule Base (3/3) To run a rule base on a heavy part with many features, it can be quicker to run the manual optimized solve option that will run only on features that changed since the last solve operation. The manual optimized solve operation can work only if a complete solve has already run once and if the Rule Base setting has been set to Manual Solve
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Automatic options will make the solve run each time the update of the current workbench runs
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Using the Check Analysis (1/2) When Expert checks are not respected, the check analysis helps you identify more accurately which features of the document are concerned 1



Click on check analysis icon in the Knowledge toolbar



2 The check analysis dialog box shows all the problems concerning expert checks and advisor checks, if you want some more precision, double click on a row in the list
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Using the Check Analysis (2/2) 4



Select the Limit field



5



The selected feature is displayed and also highlighted in geometry



This button allows you to have a look at an HTMLor XML report concerning the expert checks
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This button allows you to launch macros included in the expert checks and supposed to make the expert checks respected by modifying features attributes
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Be careful : when you launch the correction, you launch all macros of all expert checks of the document
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Generating a Rule Base Report (1/3) Once the rule base solved, it is possible to view reports in order to have a detailed result of the expert checks’ verification.
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A



The first way is to select report command in contextual menu of the rule base



When generating an HTML report, it is best to have the HTML browser already open before the generation. When generating a File, a CATIA browser will display it and allow you to save it as a .txt file.
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The type and location of the report file(s) depend on the settings of the rule base
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Generating a Rule Base Report (2/3) B



The Second way is to click on the report icon in the Check analysis dialog box, but again it is better to have the HTML browser already open before the report generation.
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The file type and its location depends on CATIA settings defined in Tools->Options
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Generating a Rule Base Report (3/3)
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When consulting an html report do not hesitate to click on the underlined info to consult more accurate sub reports



Instructor Notes:



Copyright DASSAULT SYSTEMES



CATIA Knowledge Fundamentals



Customizing a Rule Base Report (1/3) There are two ways to customize reports and their related settings.



Method 1 Contextual menu Customize the settings:



1 Select the Settings command in the Rule Base’s contextual menu



Type of generated report Location of the report Length of the report if it is a text report Kind of information displayed in the report
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Format of the report



3



Use the Report option in the rule base’s contextual menu to generate it
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2
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Customizing Rule Base Reports (2/3) Method 2 Tools / Options menu Select Tools/Options



4



Select the report icon in the check analysis dialog box to generate the report.
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1
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2



Click on Parameters and Measures



3



Click on Report Generation. See next page for detailed options.
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Customizing Rule Base Reports (3/3) 3b



The Options panel lets you customize:



The type of the generated report The style sheet for a XML report The content of the report: -if all checks are displayed or only the failed ones -if advisor checks are displayed or not -If expert checks are displayed
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The location of the generated file
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Whether the HTML browser of CATIA is open instead of using Netscape Communicator or Internet Explorer
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Grip Assembly Recap Exercise 30-45 min



In this exercise you will study an assembly containing a grip and shaft. Our requirements are: The main hole of the Grip must always match with the axis of the Shaft. The length of the Shaft and the length of the Grip should be controlled from the Product level. The Shaft component can be replaced with another one, but all parameters and links created between the Grip and the Shaft must be maintained. Some standard company knowledge rules will be applied on the Grip component.
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Topics covered: Creating formulas Publishing and Importing Parameters in Context Importing and using Checks Importing and Analyzing Rule Bases
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To Sum Up



You have seen examples of collaborative work with CATIA Knowledge tools: How to share parameters between documents How to import and adapt Knowledge Advisor existing features into your document
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How to import, solve and analyze existing Rule bases in your document
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Stringer Assembly Exercise You will practice the Stringer Assembly Exercise.
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Stringer Assembly Exercise Presentation Stringer Assembly Exercise: Step 1 Stringer Assembly Exercise: Step 2 Stringer Assembly Exercise: Step 3 Stringer Assembly Exercise: Step 4 Stringer Assembly Exercise: Step 5 Stringer Assembly Exercise: Step 6 Stringer Assembly Exercise: Step 7
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Stringer Assembly Master Exercise Presentation 60 min
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Topics covered: • Embedding knowledge in the existing assembly • Creating User parameters, formulas and Design Tables • Publishing and importing parameters • Importing and using Rules and Checks
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Stringer Assembly Step 1 : Creating user parameters and formulas 10 min



In this step you will: Create new user parameters, Length and Width



•



These parameters represent the width and the length of the Bracket.



•



Use these parameters in order to edit formulas.
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•
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Stringer Assembly Step 2: Importing Rules and Checks 10 min



In this step you will: Import an existing rule that will control the Thickness of the material and the CriticalThickness parameter by specific material



•



Import an existing checks that will control minimum distances of the hole for fastening and the hole of the Rod component.
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Stringer Assembly Step 3: Creating a Design Table and changing its configuration 10 min



In this step you will: Create the Design Table from user parameters, Change the configuration of the Bracket.
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• •
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Stringer Assembly Step 4: Publishing Parameters 5 min



In this step you will: Publish some parameters of the Bracket component.



•



The parameters can be used within other parts in formulas.
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Stringer Assembly Step 5: Creating formulas in an existing assembly 10 min



In this step you will: Create new user parameters at product level, Create formulas in order to control the general proportions of the Bracket and of the Stringer from the assembly level.
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• •
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Stringer Assembly Step 6 : Using parameters as external references 15 min



In this step you will: Use the published parameters of the Bracket as imported parameters in formulas of the Stringer component.



•



Dissociate the HolesDiameter parameter from the Design Table of the Bracket and then associate it to a published parameter of the Bolt with a formula.
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Stringer Assembly Step 7: Replacing the Bolt component 5 min



In this step you will: Change the configuration of the User parameters. Replace the Bolt component with the rivet and update assembly.
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• •



Instructor Notes:



Copyright DASSAULT SYSTEMES



























des documents recommandant







[image: alt]





CATIA Knowledge Fundamentals 

Sep 19, 2008 - Or with multiple values (discrete). In this case, the parameter can ...... (shell thickness in this case) in according to what is defined in its script.Missing:










 


[image: alt]





CATIA Knowledge Fundamentals 

Sep 19, 2008 - Grip Assembly Recap Exercise. 26. Design Process. 27. Step 1: Create User Parameters at Assembly Level. 29. Step 2: Publish Parameters. 30.










 


[image: alt]





CATIA V5 Fundamentals - MAFIADOC.COM 

Each case study contains a set of model requirements, known as the design intent. The first case study does not contain a design intent because you are not ...Missing:










 


[image: alt]





CATIA V5 Fundamentals 

Aug 19, 2008 - August 2008 .... Individual case studies are used as building blocks towards the completion of a final .... CATIA V5 is specifically designed for the Windows operating environment, and ..... The documentation may also be installed on a










 


[image: alt]





CATIA V5 Fundamentals .fr 

Aug 19, 2008 - CATIA V5 Fundamentals course is to teach you how to build parts ... in which you would use particular tools and methods, and illustrate ... All models used in the case studies come from the Drill Press assembly, which is .... Let's see










 


[image: alt]





CATIA V5 Fundamentals - MAFIADOC.COM 

Product. Design. Generative ... feature-based, parametric solid modeling design tool that ... fully associative 3D solid models, with or without ...... the depth to cut through the entire pad. Conf. ...... F. Auxiliary View: created in a given direct










 


[image: alt]





Product Knowledge Template CATIA V5 Training 

Jan 19, 2009 - EXERCISE BOOK. Copyright ... Students attending this course should have knowledge of CATIA V5 ...... For manual inputs, selection is done by.










 


[image: alt]





CATIA FEM Solid - CATIA design 

Jan 19, 2009 - Right click on them, choose â€œDeactivateâ€�. â€¢ Click â€œRotation Mesher â€œ icon. â€¢ Select the tetrahedron filler mesh for the meshpart. â€¢ Select the ...










 


[image: alt]





fundamentals 

email: [email protected] - www.editions-bim.com. This work is in all its parts ... jeden zur Suche nach der persönlich best- ... good playing condition.










 


[image: alt]





3. Global knowledge management Knowledge 

network of capital, product, and knowledge transactions among units in ..... redrawing â€“ rechecking etc a self-optimizing loop was created to constantly improve.










 


[image: alt]





Antenna Fundamentals 

Radio waves are polarized depending on the structure that ... cal antenna is used to receive the radio frequency ..... RG8/U. An 83-185 adapter may be used with ...










 


[image: alt]





Knowledge, management, and knowledge management in 

vision, science, technology, management theory, as well as the information ..... knowledge management is an advanced level for discussing technology, R&D, or.










 


[image: alt]





Knowledge use 

De leur cÃ´tÃ©, les utilisateurs peuvent participer Ã  des ateliers de travail (workshop) afin d'acquÃ©rir les nouvelles connaissances et les intÃ©grer Ã  leur pratique. Finalement, les ..... D'un cÃ´tÃ© les mÃ©thodes traditionnelles tentent de mesur










 


[image: alt]





Knowledge Advisor 

Jan 19, 2009 - Students attending this course should have knowledge of CATIA V5 ..... The Publication command is available in Assembly Design and Part ...










 


[image: alt]





3. Global knowledge management Knowledge Creation and 

being â€œdifferences in language, education, business practices, culture, and industrial .... such as Dow Chemicals, Shell, BASF and other with valves for chemical and petro-chemical ..... Journal of International Business Studies, 30(3): 439-462.










 


[image: alt]





Knowledge Expert 

Jan 19, 2009 - Create an expert check on the constant edgefillets' radius. Make a report on the ... Run a Complete Manual Solve on the rule base and check.










 


[image: alt]





Knowledge Expert 

Jan 19, 2009 - automated using VBScript macros, texts or it can be linked to URL files. ... To display the parameters in the tree defined in the part document. 2).










 


[image: alt]





Knowledge Advisor 

Jan 19, 2009 - if ( Bulb_Height / Bulb_Diameter ) > 1.7. {. Glass_Bulb\Radius_Bulb = Bulb_Height / (2*1.7). Bulb_Ratio = 1.7. Message ("The Ratio has ...










 


[image: alt]





Knowledge Advisor 

Jan 19, 2009 - Types available in the â€œFilter Typeâ€� list are the types of parameters found in the current selection. you can make a query per name â€¦or per type:.










 


[image: alt]





ASSEMBLAGE sous CATIA V5 

ASSEMBLAGE sous CATIA V5. 1. L.LEVREL. Assemblage sous catia V5 R14.doc. DÃ©marrer -> Conception mÃ©canique -> Assembly Design pour lancer l'atelier.Missing:










 


[image: alt]





CATIA V5 Analysis 

Jan 19, 2009 - parts and assemblies designed in CATIA. This course focuses .... and post-process the part or assembly in the case study. Each step contains ...










 


[image: alt]





CATIA Product Design Expert 

Sep 19, 2008 - Housing part as there is NO conflict between the geometrical and assembly constraint. ...... Calculated in Clash, Clearance, Contact. Yes. No.










 


[image: alt]





CATIA Mold Tooling Design 

Jan 19, 2009 - Select new Product in the specification tree (orange highlight) ... Page 5 ... Select in the dialog box the design table icon corresponding to ...










 


[image: alt]





CATIA V5 Surfaces 

Aug 19, 2008 - To create spline or a polyline, you only need points. And to create a circle, you only .... Important: the curve is deformed and you control the maximum deviation ...... And stress the fact that it requires a lot of work. This is far f










 














×
Report CATIA Knowledge Fundamentals





Your name




Email




Reason
-Select Reason-
Pornographic
Defamatory
Illegal/Unlawful
Spam
Other Terms Of Service Violation
File a copyright complaint





Description















Close
Save changes















×
Signe






Email




Mot de passe







 Se souvenir de moi

Vous avez oublié votre mot de passe?




Signe




 Connexion avec Facebook












 

Information

	A propos de nous
	Règles de confidentialité
	TERMES ET CONDITIONS
	AIDE
	DROIT D'AUTEUR
	CONTACT
	Cookie Policy





Droit d'auteur © 2024 P.PDFHALL.COM. Tous droits réservés.








MON COMPTE



	
Ajouter le document

	
de gestion des documents

	
Ajouter le document

	
Signe









BULLETIN



















Follow us

	

Facebook


	

Twitter



















Our partners will collect data and use cookies for ad personalization and measurement. Learn how we and our ad partner Google, collect and use data. Agree & Close



